Change in Lab Schedule

• Go-No-Go Lab this week.
• Personality Lab next week.
  • The course syllabus has been updated.
Today’s events

• Go over method section
  • Lab Report 2 due: by the start of Lab during the week of October 7th
APA Roadmap

- Title Page
- Abstract
- Introduction
- Method
- Results
- Discussion
- References
Introduction: Method Section

• Introduction answers “Why” (and we’ll get to it!)
• Method section answers “How” for your study
  • To do so, the method section must answer:
    • Who?
    • What?
    • Where?
    • How?
Method

• So why should we include it?
  – To make sure the results are meaningful
    • Example: A study (N = 2000) finds that 100% of Americans rank chocolate as one of their five favorite foods.
    • The methods section is where we learn that the people surveyed were those on a Hershey Factory tour.
  – So other researchers can replicate it
    • Assuming of course, that it WAS done well
    • Allows others to critique and improve on experimental design
  – Identify possible confounds
  – Limitations go in the discussion section
APA Formatting: Methods

• Past Tense: You have already conducted the study
• Active voice
• Center “Method”
  • No extra space after introduction
  • No bold, underline or italics
• Participants, Materials, and Procedure
  • Flushed left
  • Italicized
Getting down to business

• Label your subsections
  • Participants
  • Materials
  • Procedure
  • Others if needed (Design and Analyses, Apparatus, etc.)

• Watch Formatting!!!
Method

Participants

• Number of participants in the study? (N = ?)
• What screening criterion was there? Were any groups excluded and if so, why?
• Basic demographics
  • General characteristics (older adults, Ford mechanics, psychiatric patients, etc.)
  • Age, gender, race
  • Only include what is relevant to your study
    • Example: A study of jellybean flavor preference. Participants’ religious preference is not relevant.
• Specific demographics when relevant
  • e.g. income levels, profession, relationship status, nationality, etc.
Participants: our study

• Number
  • How many after missing data is eliminated?
    • For Go-No-Go, there were 8 participants eliminated for incomplete data.

• Demographics
  • Find the number (or percent) of males and females
  • Age range, mean, and standard deviation
  • Ethnicity codes: 1 = Caucasian, 2 = , etc.
    • Number/percent of each group
  • Where did we recruit participants?
  • Were they compensated?
Method

Participants

Participants were 239 (40 men and 199 women) undergraduates at a university in the Southeastern U.S. who completed a survey in exchange for credit toward a course requirement. Participants’ median age was 21, and they described themselves as White (55.6%), Black (18.8%), Latino/a (10.4%), Multiracial (5.4%), Asian (4.6%), Arabic (1.3%), and Other (3.8%). Because we focused here on an identity (nerd) whose cross-cultural and cross-linguistic generalizability was unknown to us, we restricted eligibility to native English speakers. Participation in this study was on a voluntary basis. Compensation in the form of extra credit and course credit for academic coursework was provided for some participants enrolled in specific undergraduate college courses. Participants who failed the manipulation check ($n = 22$) were excluded in further analyses.
Method

Materials

• All materials utilized for the study (rat maze, jump rope, computer game, etc.)
• Which ones were used?
  • Why was it chosen?
  • Validity (don’t need to have for Go-No-Go)
  • Reliability (don’t need to have for Go-No-Go)
  • If measure is obscure or new, go into more details about the scale, items, etc.
Method

Materials

• When surveys are used, must provide details about the measures
  • Short description of measure
  • Number of items
  • Response format
    • Likert scale, open-response, T/F, etc.
  • Interpretation information
    • high scores mean...
    • low scores mean...
Materials (Surveys cont.)

- Sample questions
- Reliability and Validity
- If you created the measure include info about the process (construct validity)
- Include all items from original measures in the appendix
- When using a pre-existing published measure:
  - Include full name of measure followed by abbreviation and citation of original author
  - Ex: Occupational Stress Indicator (OSI; Cooper, 1997)
    - After that, you can call it the OSI.
Implicit Identity

Participants
See previous example.

Materials

Participants responded to all survey items using a 5-point Likert scale (from 1 = “Strongly disagree” to 5 = “Strongly agree”).

For the explicit measure of identity, employees completed Selenta and Lord’s (2005) Levels of Self-Concept Scale (LSCS; evidence for the validity of this measure is reported by Johnson & Chang [2006] and Johnson et al. [2006]). Individual identity was measured using the 5-item comparative identity subscale (α = .85), which reflects the motivation to demonstrate one’s uniqueness and personal success (e.g., “I have a strong need to know how I stand in comparison to others”). Relational identity was measured using the 5-item concern for others subscale (α = .86), which reflects the motivation to work towards the welfare of another person (e.g., “It is important to me that I uphold my commitments to significant people in my life”).
Method

**Procedure**

- Step-by-step of how you collected the data.
  - Peanut-butter jelly example. Like a recipe.
- Could another researcher repeat the experiment just by reading what you wrote here? If not, add more detail.
- Were surveys filled out in a classroom? The mall? Was the researcher present?
Procedure (cont.)

- Include RELEVANT details, but don’t overdo it
  - “The participants sat at a folding table purchased from the Target in Detroit. There was a small coffee stain 2 inches in diameter located 3 feet to the right of the participant, and one of the legs is slightly bent from when the research staff dropped it down a flight of stairs…”
  - Or, “The experimenter walked into the room and set down his pen. He started to open his dry mouth, but took a drink of water before talking to the participants.”
Procedure (cont.)

• Write in order which events occurred
  • usually starts with informed consent procedure
• Discuss experimental design
  • Describe each condition, how students were assigned to each condition (randomly assigned), counterbalancing, etc.
• When? (during regular class time?)
• Instructions to participants
• Where? (each person in own room or group format?)
• How? (paper and pencil? Internet? All in one packet? Order of measures?)
• Debriefing
Method

Participants

Procedure
Miscellaneous info

• Do not include limitations of method/measures in Methods section
• Should be 1-2 pages, depending on how detailed
• Please be sure you address everything in the lab report
• If you do not have some information (such as demographics), be sure to tell the reader that.
• Remember: You can always ask your TA for guidance.
Participants: 47 Lecturers

Procedures: How lecturers were observed.

Reliability
Method

Participants

Use this section to describe your sample. Participants (14 women, 10 men, Mage = 19.5 years, age range: 18-22 years) were recruited with flyers poster around the campus. Participants were compensated $10 per hour for their participation.

Materials

The materials subsection is not always included. But, this is the area you would describe the mechanical equipment, software, or any other material you used to collect the data. The idea is to provide enough information so that another researcher could replicate your study.

Procedures

This section should describe and operationally define all of the variables. Moreover, the design of the study should be described. Finally, the procedure subsection should describe exactly what happened to the participants in the study.
Method Section Review

• What is the purpose of the Method section?
  • It describes the study in detail

• Which subheadings go in the Method section?
  • Participants
  • Materials
  • Procedure

• Name the three components that must be in the participant subheading:
  • Number
  • Demographics
  • Recruitment and Compensation
Method checklist for a critical reader

• Is my proposed method better than the author’s?
• Does the author’s method actually test the hypothesis?
• What are the independent, dependent, and control variables?
• Using the subjects, apparatus or materials, and procedures described by the author, what results would I predict for this experiment?
Resources

• Purdue Online Writing Lab (OWL) is a good resource for APA styling
  • [http://owl.english.purdue.edu/owl/section/2/10/](http://owl.english.purdue.edu/owl/section/2/10/)
• Sample paper from APA
• Your wonderful TA’s
Things to learn for Lab Report 2

- Data Analysis of Go-No-Go Lab
- Making a Table
- Making a Figure
Recall the Go-No-Go Task

- Measures pre-potent response inhibition.
  - Saw a ‘+’ and told to focus on that ‘+’.
  - Then you saw either an ‘o’ or an ‘x’.
  - If you saw an ‘o’ you were told to hit the spacebar.
  - If you saw an ‘x’ you were told not to hit any key.
Recall the manipulation

• In the experiment we manipulated the points for correctly responding:
  • In the unbias condition you got
    • 10 points for correctly hitting spacebar after seeing an ‘o’.
    • 10 points for correctly NOT hitting the spacebar after seeing an ‘x’.
  • In the bias condition you got
    • 1 point for correctly hitting spacebar after seeing an ‘o’.
    • 20 points for correctly NOT hitting the spacebar after seeing an ‘x’.
So what do we want to test?

• In the bias condition:
  • Should we see more or less spacebar hits following an ‘o’?
    • Less
  • Should we see more or less spacebar hits following an ‘x’?
    • Less

• To test this prediction we are going to use the data you helped generate.
Getting the SPSS data

• We have put the data in a SPSS file. Download the file from Angel in the Go-No-Go Lab folder (Go-No-Go data).
  • Save it to your P drive or to a folder you will have permanent access to (like a USB drive).
  • Or email it to yourself
  • REMEMBER DON’T SAVE TO DESKTOP
Opening the data file

- In SPSS go to Open → Data
- Select the “Go-No-Go Data.sav” file that you saved and open it
Opening the data file

- Your data file should look like this:
Each row is a participant (one of them is you)

<table>
<thead>
<tr>
<th>ParticipantID</th>
<th>Unb_Spc_O</th>
<th>Unb_No_O</th>
<th>Unb_No_X</th>
<th>Unb_Spc_X</th>
<th>Bias_Spc_O</th>
<th>Bias_No_O</th>
<th>Bias_No_X</th>
<th>Bias_Spc_X</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4325.00</td>
<td>41.00</td>
<td>15.00</td>
<td>20.00</td>
<td>4.00</td>
<td>25.00</td>
<td>31.00</td>
<td>15.00</td>
</tr>
<tr>
<td>2</td>
<td>6028.00</td>
<td>40.00</td>
<td>16.00</td>
<td>15.00</td>
<td>9.00</td>
<td>40.00</td>
<td>16.00</td>
<td>16.00</td>
</tr>
<tr>
<td>3</td>
<td>24627.00</td>
<td>41.00</td>
<td>15.00</td>
<td>21.00</td>
<td>3.00</td>
<td>43.00</td>
<td>13.00</td>
<td>21.00</td>
</tr>
<tr>
<td>4</td>
<td>29635.00</td>
<td>44.00</td>
<td>12.00</td>
<td>20.00</td>
<td>4.00</td>
<td>43.00</td>
<td>13.00</td>
<td>21.00</td>
</tr>
<tr>
<td>5</td>
<td>33077.00</td>
<td>36.00</td>
<td>20.00</td>
<td>20.00</td>
<td>4.00</td>
<td>24.00</td>
<td>32.00</td>
<td>21.00</td>
</tr>
<tr>
<td>6</td>
<td>48173.00</td>
<td>48.00</td>
<td>8.00</td>
<td>21.00</td>
<td>3.00</td>
<td>50.00</td>
<td>6.00</td>
<td>23.00</td>
</tr>
<tr>
<td>7</td>
<td>48543.00</td>
<td>42.00</td>
<td>14.00</td>
<td>10.00</td>
<td>14.00</td>
<td>45.00</td>
<td>10.00</td>
<td>14.00</td>
</tr>
<tr>
<td>8</td>
<td>48546.00</td>
<td>39.00</td>
<td>17.00</td>
<td>13.00</td>
<td>11.00</td>
<td>36.00</td>
<td>20.00</td>
<td>15.00</td>
</tr>
<tr>
<td>9</td>
<td>48624.00</td>
<td>47.00</td>
<td>9.00</td>
<td>17.00</td>
<td>7.00</td>
<td>32.00</td>
<td>24.00</td>
<td>15.00</td>
</tr>
<tr>
<td>10</td>
<td>48704.00</td>
<td>37.00</td>
<td>19.00</td>
<td>18.00</td>
<td>6.00</td>
<td>40.00</td>
<td>16.00</td>
<td>18.00</td>
</tr>
<tr>
<td>11</td>
<td>48829.00</td>
<td>38.00</td>
<td>18.00</td>
<td>17.00</td>
<td>7.00</td>
<td>3.00</td>
<td>53.00</td>
<td>22.00</td>
</tr>
<tr>
<td>12</td>
<td>48927.00</td>
<td>.00</td>
<td>14.00</td>
<td>11.00</td>
<td>13.00</td>
<td>31.00</td>
<td>25.00</td>
<td>17.00</td>
</tr>
<tr>
<td>13</td>
<td>49111.00</td>
<td>41.00</td>
<td>15.00</td>
<td>7.00</td>
<td>17.00</td>
<td>37.00</td>
<td>19.00</td>
<td>16.00</td>
</tr>
<tr>
<td>14</td>
<td>49165.00</td>
<td>40.00</td>
<td>16.00</td>
<td>21.00</td>
<td>3.00</td>
<td>33.00</td>
<td>23.00</td>
<td>22.00</td>
</tr>
<tr>
<td>15</td>
<td>49250.00</td>
<td>47.00</td>
<td>9.00</td>
<td>23.00</td>
<td>1.00</td>
<td>33.00</td>
<td>23.00</td>
<td>22.00</td>
</tr>
</tbody>
</table>

- **Unb_Spc_O** is the number of times each participant pressed the spacebar after seeing the o in the unbias condition
- **Unb_No_O** is the number of times each participant did not press the spacebar after seeing the o in the unbias condition
- **Unb_Spc_X** is the number of times each participant pressed the spacebar after seeing the x in the unbias condition
- **Bias_Spc_O** is the number of times each participant pressed the spacebar after seeing an o in the bias condition
- **Etc…**
Testing our hypotheses

• In the bias condition:
  • Should we see more or less spacebar hits following an ‘o’?
    • Less
  • Should we see more or less spacebar hits following an ‘x’?
    • Less

• To test this questions we need to transform the frequency counts into proportions.
We should do our tests on proportions

- To make comparisons more intuitive we will transform the raw data into proportion:
  - Freq of Space Bar Presses to Proportion of Space Bar Presses
- Use the Transform → Compute Variable
To calculate a proportion identify a Target Variable: PrUnbSpcO

Then tell SPSS what this target variable is equal to by dropping the variable you want to transform (Unb_Spc_O) into the “Numeric Expression” box.

Divide that variable by the total number of times the participant saw an o: Unb_Spc_O + Unb_No_O
Target Variable: PrUnbSpcO

Numeric Expression:

\[ \frac{Unb\_Spc\_O}{Unb\_Spc\_O + Unb\_No\_O} \]
Now calculate the proportion of times people hit space after seeing an ‘x’
Calculate the 2 proportions for the bias condition

• Now do it for:
  • Proportion of times pressed spacebar after seeing an ‘o’ in the bias, PrBiSpcO
  • Proportion of times pressed spacebar after seeing an ‘x’ in the bias, PrBiSpcX
Descriptive Statistics

• For your assignment you need to calculate the average proportion of times participants correctly and incorrectly hit the spacebar.
  • You also need the standard deviation, and the number of observations.

• Use SPSS’s Descriptive Statistics
Descriptives
DESCRIPTIVES VARIABLES=PrUnbSpcO PrUnbSpcX PrBiSpcO PrBiSpcX
/STATISTICS=MEAN STDDEV MIN MAX.

Descriptives

[Data Set] E:\PSY 395\Labs\Lab 4\Data\Go-No-Go Data Full.sav

<table>
<thead>
<tr>
<th></th>
<th>N</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Mean</th>
<th>Std. Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>PrUnbSpcO</td>
<td>167</td>
<td>.00</td>
<td>.95</td>
<td>.6710</td>
<td>.15541</td>
</tr>
<tr>
<td>PrUnbSpcX</td>
<td>167</td>
<td>.00</td>
<td>.83</td>
<td>.3106</td>
<td>.17537</td>
</tr>
<tr>
<td>PrBiSpcO</td>
<td>167</td>
<td>.00</td>
<td>.96</td>
<td>.5496</td>
<td>.19526</td>
</tr>
<tr>
<td>PrBiSpcX</td>
<td>167</td>
<td>.00</td>
<td>.79</td>
<td>.2196</td>
<td>.15173</td>
</tr>
<tr>
<td>Valid N (listwise)</td>
<td>167</td>
<td>.00</td>
<td>.79</td>
<td>.2196</td>
<td>.15173</td>
</tr>
</tbody>
</table>
Information for the table and figure (Q3 & Q4)

Descriptives

<table>
<thead>
<tr>
<th>Descriptive Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td>PrUnbSpcO</td>
</tr>
<tr>
<td>PrUnbSpcX</td>
</tr>
<tr>
<td>PrBiSpcO</td>
</tr>
<tr>
<td>PrBiSpcX</td>
</tr>
<tr>
<td>Valid N (listwise)</td>
</tr>
<tr>
<td>N</td>
</tr>
<tr>
<td>167</td>
</tr>
<tr>
<td>167</td>
</tr>
<tr>
<td>167</td>
</tr>
<tr>
<td>167</td>
</tr>
<tr>
<td>167</td>
</tr>
</tbody>
</table>

Is PrUnbSpcO > PrBiSpcO?
Is PrUnbSpcX > PrBiSpcX?

Let’s run the inferential statistics.
Correlated-group or “paired” $t$ Test

- We have repeated observations per participant.
- We need to use the correlated or paired $t$ Test
- Use when research calls for
  - Two observations on each participant (e.g., before and after treatment)
  - Observations on paired individuals (e.g., mother-daughter)
  - In general, observations that can be paired in a meaningful way and the question is whether the two sets of observations differ significantly (with $H_1$ being either directional or non-directional)
Correlated-group or “paired” $t$ Test

- Recall $t$-test for a single group,

\[
t_{obt} = \frac{\bar{X} - \mu}{S_{\bar{X}}} \quad \text{and} \quad s_{\bar{X}} = \frac{s}{\sqrt{N}}
\]

- The correlated-group test is identical to the $t$-test for single groups except that it is on the difference between the paired scores
- Use df = N-1, where N is the number of pairs of observations
T-Test of Paired Samples

- Take differences of observations
- Use the $t$-test to compare the observed mean difference to the expected, or population mean, difference under $H_0$, which usually is 0.

\[ t_{obt} = \frac{D_{obt} - \mu_D}{s_D} \]

- Use df = N-1, where N is the number of pairs of observations

\[ s_D = \frac{s_D}{\sqrt{N}} \]
<table>
<thead>
<tr>
<th>ParticipantID</th>
<th>Unb_Spc_X</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4325.00</td>
</tr>
<tr>
<td>2</td>
<td>6028.00</td>
</tr>
<tr>
<td>3</td>
<td>24627.00</td>
</tr>
<tr>
<td>4</td>
<td>29636.00</td>
</tr>
<tr>
<td>5</td>
<td>33077.00</td>
</tr>
<tr>
<td>6</td>
<td>48173.00</td>
</tr>
<tr>
<td>7</td>
<td>48443.00</td>
</tr>
<tr>
<td>8</td>
<td>48546.00</td>
</tr>
<tr>
<td>9</td>
<td>48624.00</td>
</tr>
<tr>
<td>10</td>
<td>48704.00</td>
</tr>
<tr>
<td>11</td>
<td>48829.00</td>
</tr>
<tr>
<td>12</td>
<td>48927.00</td>
</tr>
<tr>
<td>13</td>
<td>49111.00</td>
</tr>
<tr>
<td>14</td>
<td>49165.00</td>
</tr>
<tr>
<td>15</td>
<td>49260.00</td>
</tr>
<tr>
<td>16</td>
<td>49307.00</td>
</tr>
<tr>
<td>17</td>
<td>49311.00</td>
</tr>
<tr>
<td>18</td>
<td>49327.00</td>
</tr>
<tr>
<td>19</td>
<td>49328.00</td>
</tr>
<tr>
<td>20</td>
<td>49361.00</td>
</tr>
<tr>
<td>21</td>
<td>49404.00</td>
</tr>
<tr>
<td>22</td>
<td>49463.00</td>
</tr>
</tbody>
</table>

**Compare Means**

- General Linear Model
- Generalized Linear Models
- Mixed Models
- Correlate
- Regression
- Loglinear
- Neural Networks
- Classify
- Dimension Reduction
- Scale
- Nonparametric Tests
- Forecasting
- Survival
- Multiple Response
- Missing Value Analysis
- Multiple Imputation
- Complex Samples
- Simulation
- Quality Control
- ROC Curve
T-Test of Paired Samples

Drop PrUnbSpcO into the first position.

SPSS calculates the differences for you.

Drop PrBiSpcO into the second position...
Calculate the Inferentials

This table tells you the result of the $t$-test comparing the hit rates (proportion of times hit the spacebar after seeing the ‘o’ for bias and unbias).

Now do the test for the false alarms (hit the spacebar following an ‘x’).
Your tables should look like this:

1.) Notice the table number and titles
2.) The headings for each column
3.) Only horizontal lines

Table number

Table title

Table 1

The average (SD) percentage of times the spacebar was hit correctly and incorrectly.

<table>
<thead>
<tr>
<th></th>
<th>Unbias</th>
<th>Bias</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correctly after an ‘o’</td>
<td>88 (7)%</td>
<td>76 (8)%</td>
</tr>
<tr>
<td>Incorrectly after an ‘x’</td>
<td>56 (7)%</td>
<td>46 (10)%</td>
</tr>
</tbody>
</table>

Center the headings

Times New Roman 12 point
Double space

Only horizontal lines and
Only at the bottom and around the headings.

NOTE: This is using made-up data.
Under the menu “Insert” select Table. Then select how big the table should be. In this case 3 x 3

A table will appear. Then enter the data from the SPSS output accordingly. Put standard deviations in parentheses.
Tables in APA formatted papers only have vertical lines. And only a few special vertical lines.

So first highlight the table. Then still under the Insert menu select the “Border” menu:

Choose “No Border”

The table will look like this.

Now go back to the Border menu and add a top border above the column headings. A bottom border below column headings. And a bottom border at the bottom of the table.
Table 1

The average (SD) percentage of times the spacebar was hit correctly and incorrectly.

<table>
<thead>
<tr>
<th></th>
<th>Unbias</th>
<th>Bias</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correctly after an ‘o’</td>
<td>88 (7)%</td>
<td>76 (8)%</td>
</tr>
<tr>
<td>Incorrectly after an ‘x’</td>
<td>56 (7)%</td>
<td>46 (10)%</td>
</tr>
</tbody>
</table>
Making a Figure

NOTE: This is using made-up data.

Figure 1. The average percentage of times the spacebar was hit correctly and incorrectly.
Use Excel

Enter the descriptive data in a format organized like shown.

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ave</td>
<td>Proportion</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Unbias</td>
<td>Bias</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Correctly after an 'o'</td>
<td>88</td>
<td>76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Incorrectly after an 'x'</td>
<td>56</td>
<td>46</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Highlight the data like this.

Then go to

Insert → Column → 2-D Column → Clustered Column
A graph will appear.

Now you can change the colors to make it more friendly for black and white printing.

Right click on one of the Blue Bars.

Do the same for the red. Note you have to add a border color if you make something white.
Add an Axis Label for the Vertical (Y) Axis

When you have the graph “selected” you should see a “Chart Tools” menu.

Then choose Chart Tools → Layout → Axis Titles → Rotated Title.

An “Axis Title” will come up.
Click on it to get the cursor in there and add a label.

NOTE: This is using made-up data.